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1. Introduction 

Congratulations on choosing the ALVA BC640. The ALVA Braille Controller 6-series is 
the first series of wireless Braille Controllers that merges classic Braille display access 
with modern note taking functionality. The high quality and reliability of the ALVA BC640 
gives you optimal flexibility and productivity in an ultra compact design. 
 
The ALVA BC640 features future proof hardware standards as wireless Bluetooth® 
connection and USB ports. The ergonomic design with its high quality Braille cells and 
optimal navigation possibilities allow you to be in full control of your computer, PDA or 
(smart) phone. Used in combination with screen reading software the ALVA Braille 
Controller can be installed for particular operating systems to provide a tactile and 
audible user interface. 
 
The ALVA BC640 offers an enhanced ergonomic design that extends the navigation 
and operation possibilities of the screen reading software. The ergonomics are 
designed for optimal efficiency when working with a computer, PDA or Smartphone. 
Note that the functionality of the ALVA BC640 depends somewhat on the Braille 
display options of your screenreader and your mainstream computing hardware. 
 
The ALVA Braille Controller was designed to adhere to the Open Standard 
philosophy using mainstream technology. This enables compatibility with most 
screen reading software and operating systems. Contact your distributor or Optelec 
for updated information about screenreaders that fully support the ALVA BC640. 
 
If you have any questions or suggestions concerning the use of this Braille display, 
please contact your distributor or Optelec’s head office using the contact information at 
the last page of this manual. Your feedback is highly appreciated. We hope you enjoy 
working with your ALVA BC640. 
 

1.1. About this manual 
This manual will familiarize you with the features and basic operation of the ALVA 
BC640 and Braille Audio Feature Pack. Please read this manual carefully before 
using your device. 
 

1.2. ALVA BC640 package contents 
The ALVA BC640 package contains the following: 

– A pouch 
– The ALVA BC640 base unit 
– Power adapter 110/240V and power cable 
– Long and short USB cables 
– An USB Bluetooth® dongle, Class 1, Windows XP SP2 and Windows 

Vista compatible  
– The ALVA BC driver software for Windows XP and Windows Vista and 

documentation on CD-ROM 
– This manual in Print 
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– Quick Start Guide in Braille and Print 
 
The ALVA BC640  with Braille Audio Feature Pack package contains the following: 

– A carrying bag 
– The ALVA BC640 base unit including Braille Audio Feature Pack 
– Power adapter 110/240V and power cable 
– Long and short USB cables 
– An USB Bluetooth® dongle, Class 2, Windows XP SP2 and Windows 

Vista compatible  
– The ALVA BC driver software for Windows XP and Windows Vista and 

documentation on CD-ROM 
– A headset 
– This manual in Print 
– Quick Start Guide in Braille and Print 

 
The Braille Audio Feature Pack package contains the following: 

– A carrying bag 
– The Braille Audio Feature Pack 
– The ALVA BC driver software for Windows XP and Windows Vista and 

documentation on CD-ROM 
– A headset 
– A hex key 
– This manual in Print 
– Quick Start Guide in Braille and Print 

 
If any of these items are missing from your package, please contact your distributor. 
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2. Getting to know your ALVA BC640 

The ALVA BC640 consists of an ALVA BC640 base unit containing a 40 cell Braille 
line and an optional Braille Audio Feature Pack. This chapter will give a detailed 
overview of the lay-out of the ALVA BC640 base unit and Braille Audio Feature Pack. 
 

2.1. ALVA BC640 Base Unit: Surface and front panel layout 
 
The unit is placed correctly in front of you when the 40 Braille cells are located at the 
back of the flat surface and the thumb keys are facing towards you. 
 
The ALVA BC640 contains: 
 

1. 40-cell Braille display 

2. eTouch keys (left) for panning left and right and screenreading functions 
3. eTouch keys (right) for panning left and right and screenreading functions 

4. Smartpad with 5-way navigation key and 4 keys for easy access to 
mainstream devices 

5. Thumb keys for panning, left, right, up and down and returning to the cursor 
position 

6. 40 Cursor Routing Keys 
7. Power supply and mini USB connectors 

8. On/off switch 
 

             2         1      3 
 

 
  
 5    4      6 

 7              8
     

2.1.1. Surface and front panel layout 
The ALVA BC640 is designed with a row of 40 Braille cells at the back of the flat 
surface. In front of the Braille cells one row of small buttons can be found, known as 
Cursor Routing Keys. Each Braille cell has a corresponding Cursor Routing Key that 
can be used for multiple functions. On the left and right side of the Braille line you will 
find two groups of two keys. These so-called eTouch keys can be used for Braille 
panning left and right as well as various other screen-reader functions. 
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In the middle, just in front of the Cursor Routing Keys, you will find a group of 9 keys. 
This group is called Smartpad and consists of 4 function keys and a 5-way navigation 
key. The Smartpad can be used for operating mainstream devices such as PC’s, 
(smart)phones and PDA’s.  
 

2.1.2. Back panel layout 
At the back of the Braille Controller, a connector can be found for the Braille Audio 
Feature Pack.    
 

2.1.3. Right side layout 
The power switch is located at the right side of the Braille Controller. The Braille 
Controller is switched on when the rectangular push button is pressed. Switching the 
Braille Controller on will generate an audio signal. 
 

2.1.4. Left side layout 
The left side of the Braille Controller contains three connectors. From front to back: 
power connector, mini USB connector and a feature connector. The feature 
connector has no function with the release of this manual.   
 

2.1.5. Front panel keys, Smartpad, eTouch navigation buttons and 
cursor routing keys 

The names of the ALVA BC640 keys listed in this section will be used in all 
documentation, including your screenreader documentation. This section describes 
the name of the key(s) and its main function, which is supported by the screenreader. 
The exact functionality is defined by the screenreader. Please refer to your 
screenreader documentation for detailed functionality of the ALVA BC640. 
 

Smartpad 
The integrated Smartpad allows for simultaneous access to mainstream devices such 
as PC’s, PDA’s and (smart)phones and navigation through menu’s and dialog boxes.  
From left to right, the Smartpad keys are: 
Smartpad key 1    First rectangular key at the left marked with 3 horizontal lines 
Smartpad key 2    Second rectangular key at the left marked with 1 horizontal line 
LEFT       Left key on the 5-way navigation key 
UP       Top key on the 5-way navigation key 
DOWN  Bottom key on the 5-way navigation key 
RIGHT  Right key on the 5-way navigation key 
MIDDLE      Middle key marked with a round dot of the 5-way navigation key 
Smartpad key 3    Second rectangular key from the right marked with 1 vertical line 
Smartpad key 4    Most right rectangular key marked with 3 vertical lines 
 

eTouch keys 
The two keys on each side of the Braille line are called the eTouch keys. They are 
used for panning left and right as well as various other Braille functions. 
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eTouch 1  Top left key marked with two vertical lines 
eTouch 2  Bottom left key marked with one horizontal line 
eTouch 3 Top right key marked with two vertical lines 
eTouch 4  Bottom right key marked with one horizontal line 
  
Cursor Routing Keys  
The cursor routing keys correspond to the particular Braille cell immediately above 
each button. Typically, they are used for routing the cursor or caret to the 
corresponding Braille cell, generating a left or right mouse click at that point, or for 
obtaining additional information about the contents of the Braille cell. 
 

Thumb Keys 
At the front of the Braille Controller five front panel keys are placed, the so called 
thumb keys. Four bigger keys are symmetrically aligned along the front of the ALVA 
BC640. One smaller button is located in the middle of the front. Pressing one of the 
four bigger thumb keys will navigate left, right, up or down. By pressing the middle 
key you will return to the cursor position. 
 

2.2. The ALVA BC640 Braille Audio Feature Pack 
 
The Braille Audio Feature Pack is placed correctly in front of you when the Braille 
input keys are located at the back of the flat surface and the thumb keys of the ALVA 
BC640 Base Unit are facing towards you. 
 
The ALVA BC640 Braille Audio Feature Pack contains: 

1. Ctrl-key 
2. Eight key Braille keyboard (From left to right Braille key 7, 3, 2, 1, 4, 5, 6, 8) 

3. Windows key (to open the Windows Start Menu) 

4. Enter key 
5. Alt-key 

6. Headphone connector 

7. Microphone connector 
8. Space bar 

9. Volume control and mute button 

10. Integrated high quality stereo speakers 

    2 
 V V 

      1                     3  4     5 
 

 
6  7                              9 

    8 
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2.2.1. Braille Audio Feature Pack: Surface layout 
The ALVA BC640 Braille Audio Feature Pack is designed with an eight key Braille 
keyboard that is located directly behind the 40 cell Braille line. The Braille keyboard 
consist of eight Braille keys, a space bar, a Ctrl-key, a Windows key, an Enter key 
and an Alt-key and two integrated high quality stereo speakers that are located left 
and right of the Braille keyboard. The space bar is the long key that is located in the 
centre of the Braille Audio Feature Pack. The eight rectangular keys located left and 
right of the space bar are the Braille input keys. The four square keys are the Ctrl-key, 
Windows key, Enter key and Alt-key. From left to right the keys are labelled Ctrl-key, 
Braille key 7, Braille key 3, Braille key 2, Braille key 1, Windows key, Enter key, 
Braille key 4, Braille key 5,  Braille key 6, Braille key 8 and the Alt-key. 
 

2.2.2. Right Side layout 
The volume and mute button is located at the right side of the Braille Audio Feature 
Pack. Moving the button towards you allows you to turn the volume down, whereas 
moving the button away from you will raise the volume. Pressing the button allows 
you to mute the audio, which will be generated with a low beep. Pressing this button 
again will generate a higher beep and switch the mute function off. A message will be 
displayed on the Braille line to indicate if the mute function is on or off. 
 

2.2.3. Left Side lay-out 
The left side of the Braille Audio Feature Pack contains two connectors. From back to 
front you will find a 3.5 mm headphone connector and a 3.5 mm microphone 
connector. 
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3. Installation 

In this section, a general description of the installation procedure is described for the 
JAWS and Dolphin screenreaders for Windows XP and Windows Vista, the Braille 
Audio Feature Pack setup and Bluetooth® installation. Please refer to the 
screenreader documentation for instructions on how to setup and configure the 
Braille display for other screenreaders and operating systems. 
 
In case you upgraded your ALVA BC640 base unit to an ALVA BC640 with Braille 
Audio Feature Pack, please make sure to upgrade the firmware to version 1.14.0 or 
higher and Bluetooth® version 1.6.0 and 1.4.0. To learn more about the firmware 
version, please refer to chapter 4. The firmware update procedure is described in 
chapter 8. 

3.1. Setting up the USB connection  
 
The ALVA BC640 is compatible with Windows XP and Windows Vista. Older 
Windows versions are not supported. The ALVA BC640 does not need any special 
USB drivers. Windows XP or Windows Vista will automatically detect the ALVA 
BC640 and install the necessary drivers.   

1. Attach the USB cable to the ALVA BC640 and computer.  

2. A 2GB removable drive will appear on the screen. This drive contains the 
ALVA BC640 screenreader drivers for JAWS and Dolphin. 

3. Switch on the ALVA BC640. Windows will automatically install the 
necessary drivers. Generally this does not require any further user input. 
When the connection is established the ALVA BC640 will issue an audible 
signal and displays the message “USB connected”. 

4. If you use an ALVA BC640 with Braille Audio Feature Pack, the audio will 
be rerouted to the Braille Audio Feature Pack and the Braille keyboard will 
be installed. Please refer to chapter 6 for configuration instructions of the 
USB audio and eight key Braille input. 

 

3.2. Installing ALVA BC640 screenreader drivers 
 

1. Insert the ALVA BC640 software CD-ROM that came with the package in 
your computer’s disk drive. 

2. The program will automatically run if the autostart feature of your CD-ROM 
drive is enabled.  

a. If the autostart feature has not been enabled, open your Windows 
Start Menu, select ‘Run’ and type d:\setup.exe (assuming d: is the 
letter assigned to your disk drive) and press Enter.  

b. Alternatively, locate the ALVA_BC640 folder on the ALVA BC640 
removable drive and run the “ALVA BC6 Setup.exe”. 
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3. Select “Install screenreader drivers” 

4. The setup program will guide you through the installation. 

5. The setup program will automatically search your system for installations of 
JAWS and Dolphin screenreaders and will install all necessary drivers, 
manuals, firmware update software and the application to configure the 
ALVA BC640 Braille Audio Feature Pack Bluetooth® settings. Please note 
that the ALVA BC640 is only supported by Windows XP and Windows Vista. 

 
Drivers for screenreaders other than Dolphin and JAWS are included in the products 
themselves and are not shipped on the ALVA BC640 CD-ROM. Please refer to your 
screenreader documentation for more information about the setup of the ALVA 
BC640. You have the choice between two setup types: a complete and a custom 
setup. We recommend using the “Complete” setup. The “Complete” setup will 
automatically install and update all the necessary components. If you would like to 
install the ALVA BC640 software manually you can choose the “Custom” setup option. 
This option is for advanced users only. The “Custom” setup will ask you what 
components you would like to install. For each component chosen you will need to 
provide the correct installation location.  
 
Note: 
The USB audio channel in Windows is configured to mix the microphone audio with 
the playback audio. This can result in a beeping sound when connection the Braille 
Audio Feature Pack to the PC via USB. To prevent Windows from mixing the 
microphone with the playback device mute the microphone in the playback mixer of 
the Windows volume control. 

3.3. Bluetooth® connection 
 

3.3.1. Preparing for Bluetooth® connection 
With the ALVA BC640 a class 1 high range USB Bluetooth® dongle for Windows XP 
and Windows Vista is included. Depending on the Bluetooth® software included with 
other Bluetooth® modules, it will be possible that not all ALVA BC640 functionality 
will be supported. The Bluetooth® dongle and software, which is included with the 
ALVA BC640, is optimized for best performance and Bluetooth® range. We therefore 
highly recommend using the supplied dongle for best results and ease of installation. 
 

3.3.2. Setting up the Bluetooth® USB dongle 
Once the screenreader drivers have been installed, the next step is the installation of 
the supplied Bluetooth® USB dongle. 
 

1. Upon Windows start-up, insert the ALVA BC640 software CD-ROM. The 
installation program will automatically run if the autostart feature of your CD-
ROM drive is enabled. Please make sure to use the ALVA BC640 CD and 
not the Belkin CD. 

2. Select Bluetooth® Setup 

3. The setup program will guide you through the installation. 
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Warning! 

Please note that the installaton of the Bluetooth® software might take more than 20 
minutes. Please do not interrupt the setup, even when the setup appears to be 
inresponsive. Interrupting the setup will result in an incorrect installation of the 
Bluetooth® software and improper functioning of especially the ALVA BC640 Audio 
and keyboard. In case the installation has been interrupted, please uninstall the 
Bluetooth® drivers before attempting to reinstall the Belkin Bluetooth® drivers again. 
The unistallation procedure may take more than 20 minutes. Please make sure to not 
interrupt the uninstallation procedure. 
 
After installation of the Bluetooth® dongle and its software an icon named “My 
Bluetooth Places” will appear on the desktop of your Windows computer. To create 
the Bluetooth® connection with your ALVA BC640 base unit or ALVA BC640 with 
Braille Audio Feature Pack, the device will need to be paired with the PC. Once the 
ALVA BC640 has been paired succesfully, the required Bluetooth® services have to 
be activated. 
 
The ALVA BC640 without Braille Audio Feature Pack has one Bluetooth® module 
and uses one Bluetooth® service. The ALVA BC640 with Braille Audio Feature Pack 
has two Bluetooth® modules and uses four Bluetooth® services. 
 
Bluetooth® modules and services: 
 
 Bluetooth® Services 
Model Braille 

Bluetooth ® 
Serial Port 

Bluetooth® 
HID Keyboard 

Bluetooth® 
Mono Audio 

Bluetooth® 
Stereo Audio 

ALVA BC640 
witouth Braille 
Audio FP 

ALVA BC640 
Bluetooth® 
module 

   

ALVA BC640 
with Braille 
Audio FP 

ALVA BC640 
Bluetooth® 
module 

ALVA BC640 
Bluetooth® 
module 

ALVA BC640 
Bluetooth® 
module 

ALVA BC640 
FP Bluetooth 
module 

 
As indicated in the figure above, the ALVA BC640 Base Unit only uses the 
Bluetooth® serial service. However, the ALVA BC640 with Braille Audio Feature 
Pack uses two modules; one module for the serail connection or serial service, the 
HID (Human Interface Device) keyboard connection or keyboard service and the 
mono headset connection or mono headset service. The second Bluetooth® module 
is used for the stereo audio. 
 
Pairing the ALVA BC640 Base Unit (without Braille Audio Feature Pack): 
 

1. Activate the option “My Bluetooth Places” 
2. A Wizard will automatically open in Windows Explorer. 

3. Activate the “Find Bluetooth devices” option (we recommend you not to use 
the Bluetooth® setup wizard). 
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4. Locate the ALVA BC640 in the list with found devices, by using the arrow 
keys or click it once with the mouse. If the ALVA BC640 is not found, press 
the F5 key to search again. 

5. Press ALT + B for the Bluetooth® menu and select “Pair device”. 

6. To pair the ALVA BC640 with your Bluetooth® dongle, you have to enter a 
PIN code. The default code is 0000. In case you changed this number in the 
Local Menu of the ALVA BC640, please enter your personal code and press 
Enter. The ALVA BC640 is now paired with your computer. 

7. Select the ALVA BC640 from the list with found devices again and press 
Enter. 

8. Select “Dev B on ALVA BC640” to connect the serial port. A dialog box with 
the serial port number will appear. Press Enter to close this dialog box. The 
ALVA BC640 will issue an audible signal and displays the message “BT 
connected” to indicate that the connection has been established and is 
functioning. 

 

Pairing the ALVA BC640 with Braille Audio Feature Pack: 

1. Activate the option “My Bluetooth Places” 
2. A Wizard will automatically open in Windows Explorer. 

3. Activate the “Find Bluetooth devices” option (we recommend you not to use 
the Bluetooth® setup wizard). 

4. Locate the ALVA BC640 in the list with found devices, by using the arrow 
keys or click it once with the mouse. If the ALVA BC640 is not found, press 
the F5 key to search again. 

5. Press ALT + B for the Bluetooth® menu and select “Pair device”. 

6. To pair the ALVA BC640 with your Bluetooth® dongle, you have to enter a 
PIN code. The default code is 0000. In case you changed this number in the 
Local Menu of the ALVA BC640, please enter your personal code and press 
Enter. The ALVA BC640 is now paired with your computer. 

7. Select the ALVA BC640 form the list with found devices again and press 
Enter. 

8. Select “Dev B on ALVA BC640” and press Enter to connect the serial port. A 
dialog box with the serial port number will appear. Press Enter to close this 
dialog box. The ALVA BC640 will issue an audible signal and displays the 
message “BT connected” to indicate that the connection has been 
established and is functioning. 

9. Select “Headset on ALVA BC640” and press Enter to connect the mono 
audio. A dialog box confirming that the audio connection is established will 
appear. Press Enter to close this dialog box. 

10. Select “Human Interface Device on ALVA BC640” and press enter to 
connect the Braille keyboard. 

11. Press Backspace to return to the “Find Bluetooth Devices” screen. 
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12. To pair the second module of the Braille Audio Feature Pack for stereo 
audio, locate the ALVA BC640 Braille Audio Feature Pack in the list with 
found devices, using the arrow keys or clicking the mouse once. If the ALVA 
BC640 Braille Audio Feature Pack is not found, press the F5 key to search 
again. 

13. Press ALT + B for the Bluetooth® menu and select “Pair device” 
14. To pair the ALVA BC640 Braille Audio Feature Pack with the Bluetooth® 

dongle, you have to enter a PIN code. The defailt code is 0000. In case you 
changed this number in the Local Menu, please enter your personal code 
and press Enter. The ALVA BC640 with Braille Audio Feature Pack is now 
paired with your computer. 

15. Select the ALVA BC640 Braille Audio Feature Pack from the list with found 
devices again and press Enter. A dialog box confirming that the stereo audio 
connection is established will appear. Press Enter to close this dialog box. 

 
When the ALVA BC640 screenreader drivers are properly installed (see paragraph 
3.2), you might have to reload your screenreader to establish the Bluetooth® 
connection. 
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4. The ALVA BC640 Local menu 
 

This chapter describes the ALVA BC640 Local Menu. The ALVA BC640 Local Menu 
enables you to change several built-in settings of the Braille display. In case you are 
using and ALVA BC640 with Braille Audio Feature Pack, there will be two extra 
menus: the Bluetooth® connection menu and audio menu. 
 
When the ALVA BC640 is switched on, the following message is displayed: 

“ALVA BC640 ready” followed by the date and time. 

This message will automatically disappear when the screenreader is loaded and a 
successful connection with the ALVA BC640 is established.  
 

4.1. Activating the Local Menu 
To enter the ALVA BC640 Local Menu press the keys Smartpad key 2 + Smartpad 
key 3 + arrow down key simultaneously. To exit the Local Menu press Smartpad key 
1. The Smartpad keys are located on top of the ALVA BC640. The arrow keys and 
Enter key are located in the centre of the Smartpad. The four remaining keys are 
labelled from left to right Smartpad key 1 to 4. Refer to chapter 2 for a detailed 
description of the ALVA BC640 keys. 
 

4.2. Changing settings in the Local Menu 
The Local Menu allows you to configure the ALVA BC640 or review information about 
the current status of the ALVA BC640. Some menu items will only be active when a 
Braille Audio Feature Pack has been installed. These menu items will proceed with 
“FP”. 
 
Local menu     Key Combination 
Next menu item    Smartpad arrow up key 
Previous menu item    Smartpad arrow down key 
Select menu item    Smartpad Enter key 
Next field in menu item   Smartpad arrow right key 
Previous field in menu item  Smartpad arrow left key 
Change value in menu field item  Smartpad arrow up / down keys 
Accept changed value in menu field Smartpad Enter key 
 item and leave field 
Exit menu without saving changes Smartpad key 1 
 
Please note that when the menu is activated, it will be underlined with dot 7 and 8 on 
the Braille display. 
 
The Local menu has the following items: 
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Battery:  45%, charging 

 Battery presents the status of the battery and informs you if the battery is charging. 
In case the USB connection is used, the ALVA BC640 will start charging via USB 
automatically. 
The status of the battery loading can be: 
- Charging  The battery is charging  
- Not charging The battery is not charging 
 

*FP* Notes 

Notes. Press Smartpad Enter to activate the internal Notes function. 
 

Date/Time: 01/01/2008 01:00:00 

Date and time. This menu item shows the current date and time. To set the date and 
time and to change the date and time format, please refer to the set date, set time 
and date and time format menu options.  
 

Bluetooth status: connected 

Bluetooth® status displays if the ALVA BC640 Bluetooth® is connected or 
disconnected. 
 

Set Bluetooth pairable 

Set Bluetooth® pairable. Activating this menu item will disconnect the current 
Bluetooth® connection and make the ALVA BC640 visible to other Bluetooth® 
devices. Alternatively, switching the ALVA BC640 off and on will disconnect the 
current Bluetooth® connection and switches the Bluetooth® module into the pairable 
state too. 
  

Bluetooth: on 

Bluetooth®. The ALVA BC640 Bluetooth® module can be switched off. To turn 
Bluetooth® off, press Smartpad Enter key and select “off” with the Smartpad up and 
down keys. To switch Bluetooth® on again, select “on”. 
 

Bluetooth pin: 0000 

 Bluetooth® PIN. The ALVA BC640 is protected by a Personal Identification Number 
(PIN) to prevent other people from setting up a wireless connection with your Braille 
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display. This setting allows you to enter your own PIN code. By default the PIN code 
is set to 0000. This number is required when setting up a wireless connection with 
your PC or other Bluetooth® device. You can change the digits in the PIN by using 
the Smartpad Enter key and the Smartpad arrow up and down, left and right keys. 

  

Bluetooth name: ALVA BC640 

Bluetooth® Name. Specify the Bluetooth® name for the ALVA BC640. This allows 
you to uniquely identify the ALVA BC640 in case you are setting up a wireless 
Bluetooth® connection with your PC or other Bluetooth® device. By default the 
Bluetooth® name is ALVA BC640. You can change the separate characters by 
scanning through the alphabet. To change the Bluetooth® name press the Smartpad 
Enter key. Use the Smartpad arrow up and down keys to scan forward and backward 
through the alphabet. Use the Smartpad arrow left and right keys to move to the 
previous or next character. The maximum length of the Bluetooth® name is 16 
characters. In case a Braille Audio Feature Pack has been installed, the Bluetooth® 
name of the Feature Pack wil have the extension “FP”. By default the name of the 
Braille Audio Feature Pack is ALVA BC640 FP. 

Sleep: 30 

 Sleep. By default the sleep time function is set to 30 seconds. Press the Smartpad 
Enter key and set a time from 5 seconds to 255 seconds, indicating the time after 
which the Braille display puts itself into sleep mode if there is no activity. To disable 
the sleep function, select never. Consequently, the ALVA BC640 consumes virtually 
no energy when the Braille display is in sleep mode. Set the time by using the 
Smartpad arrow up and down keys. Increase the value by pressing the Smartpad 
arrow up key. Decrease the value by pressing the Smartpad arrow down key. 
 

*FP* Braille configuration 

 Braille configuration. Press the Smartpad Enter key to open the Braille 
configuration submenu. The Braille configuration submenu contains three menu 
items: keyboard layout, Braille table and contracted (Grade 2) table. These three 
items are being used to translate the Braille input on the 8 key Braille keyboard into 
text. It is therefore important to select the same keyboard layout on the ALVA BC640 
as used by Windows. Your Windows keyboard layout can be found in the Windows 
Control Panel/ Regional and Language options/ Languages/ Details. When a 
keyboard layout is selected, the ALVA BC640 will attempt to match the Braille table 
and contracted table if present. If there is no matching Braille table present, no 
changes will be made. Alternatively, you can manually select a different Braille table 
or Contracted table. The default Braille table is the NABCC (North American Braille 
Character Code) and the US English contracted table. The selected Braille table is 
used in the Local Menu. Please note that screenreaders have their own Braille tables. 
Therefore, the Braille that is being displayed on the Braille display cannot be 
controlled by the ALVA BC640. Selecting a different Braille table for displaying Braille 
should be done in the screenreader itself.  
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 To enable or disable contracted (or Grade 2) Braille input, press Space + B1245 

(Braille keys 1, 2, 4, 5). The ALVA BC640 will generate a serie of beeps to indicate 
that contracted Braille is turned on or off. Pressing Smartpad 1 allows you to exit this 
submenu. 

 

Dot pressure: 5 

Dot pressure. Select the Braille reading comfort by setting the dot pressure. If you 
prefer hard and stiff Braille dots set the value to 5. If you prefer soft and weak Braille 
dots, set the value to 1. The default setting is 5. 
 

Number status cells: 0 

Number status cells. By default the number of status cells is 0. To enable status 
cells, select a value of 1 to 20 status cells. If the statuscells are set to 0, the 
statuscells will be disabled and all 40 Braille cells are used for displaying text and 
data. Status cells provide useful information about the text on the screen, Windows 
controls and screenreader mode. 
  

Status cells: Left 

Status cells. The default position of the status cells is on the left. Select the position 
of the status cells either at the left or right side on the Braille display.  
 

Split point active: off 

Split point active. When the ALVA BC640 split point is enabled, the Braille display 
will be divided into two segments. This enables you to read and interact with two 
devices simultaneously. For example, the Bluetooth® screenreader output of a 
mobile phone can be displayed on the first 10 Braille cells while the remaining 29 
cells can be used to read the PC screenreader output via the USB connection. The 
remaining cell of the 40 cells will have all 8 dots raised to indicate where the first 
segment ends and the second segment starts. The first segment with a default length 
of 10 Braille cells will display the information send via the Bluetooth® connection. 
The second segment with a default length of 29 cells will display the information send 
via the USB connection. To enable or disable the split point feature select on or off 
using the Smartpad arrow up and down keys. Alternatively, you might enable or 
disable the split point feature by pressing the hotkeys Smartpad 2 + 3 + Enter. To be 
able to use the split point feature, please make sure your screenreaders supports this 
function. To find out if your screenreader supports the ALVA BC640 split point 
functionality, please refer to your screenreader documentation.  
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Split point: 10 

Split point. Adjust the number of cells used for the split point function by selecting 
the number of cells with the Smartpad arrow up and down keys. The first segment 
can be set from 5 to 35 cells. By changing the length of the first segment, the length 
of the second segment will automatically be adjusted. 
  

Repeat keys: on 

Repeat keys. The repeat function of the thumb keys can be enabled or disabled. 
When holding down a thumb key with the repeat function switched on, the thumb 
keys will start repeating after half a second. This enables you to quickly scroll the 
display by keeping the thumb key pressed. 

  

2nd cursor routing row: on 

2nd cursor routing row. The ALVA BC640 is equipped with one row of cursor routing 
keys. However, by keeping the cursor routing key pressed the ALVA BC640 is able to 
emulate a second row of cursor routing keys. This will give you the possibility to 
perform a left and a right mouse click with one row of cursor routing keys. When 
enabled, the ALVA BC640 will differentiate between a short and a long cursor routing 
key press. A short press will be treated as a press of a key of the first row of cursor 
routing keys, while a long press will be seen as a press of a key of the second row of 
cursor routing keys. The length of a “long press” can be set by adjusting the delay 
time. The default time is half a second. The assignment of the first and second row of 
cursor key actions depends on the used screenreader. Refer to your screenreader 
documentation for the assignment of the first and second cursor routing key actions.   

 

2nd cursor routing delay: 500 ms 

2nd cursor routing delay. The length of the delay before the second cursor routing 
key is activated can be set by adjusting the delay time. By default the delay is set to 
500 ms or half a second. 
 

*FP* Default volume: 31 

Default volume is the volume of the Braille Audio Feature Pack when the ALVA 
BC640 is switched on. The default volume is 31. 
 

Sounds: off 

Sounds can be switched on or off. When switched on, a short beep is being 
genereted on each key press. If you prefer no sounds to be generated, select “off”. 
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For each group of keys the beeps can be switched on or off individually.  
 

Cursor routing sound: on 

Cursor routing sound can be switched on or off. When switched on, a short beep is 
genereted on each cursor routing key press. If you prefer no sounds to be generated 
when a cursor routing key is pressed, select off. 
  

eTouch key sound: on 

eTouch key sound can be switched on or off. When switched on, a short beep is 
genereted on each eTouch key press. If you prefer no sounds to be generated when 
an eTouch key is pressed, select off. 
  

Thumb key sound: on 

Thumb key sound can be switched on or off. When switched on, a short beep is 
genereted on each thumbkey press. If you prefer no sounds to be generated when a 
Thumb key is pressed, select off.  
 

Smartpad sound: on 

Smartpad sound can be switched on or off. When swiched on, a short beep is 
genereted on each Smartpad key press. If you prefer no sounds to be generated 
when a Smartpad key is pressed, select off.  
 

Set time: 01:01:00 

Set time. This setting allows you to set the time. Press the Smartpad Enter key to 
enter the modification mode. Use the Smartpad arrow up and down keys to change 
the time. Use the Smartpad arrow left and right keys to select the hour, minute or 
seconds. 
 

Set date: 01:01:2008 

Set date. This setting allows you to set the date. Press the Smartpad Enter key to 
enter the modification mode. Use the Smartpad arrow up and down keys to change 
the date. Use Smartpad arrow left and right keys to select the day, month and year. 
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Date format: dd-mm-yyyy 

Date format. This setting allows you to set the date format. By default this is set to 
day / month / year. Press the Smartpad Enter key to enter the modification mode. 
Use the Smartpad arrow up and down keys to change the date format. The date can 
be displayed in the formats dd-mm-yyyy, yyyy-mm-dd and mm-dd-yyyy. 
  

Date separator: / 

Date separator This setting allows you to set the date separator. By default the “/” 
symbol is used. Press the Smartpad Enter key to enter the modification mode. Use 
the Smartpad arrow up and down keys to change the date Separator symbol. The 
date separator can be changed in a  “/”, “:”, “.” or “-“. 
 

Time format: 24 hours 

Time format. This setting allows you to set the time format. The default is the 24 
hour format. Press the Smartpad Enter key to enter the modification mode. Use the 
Smartpad arrow up and down keys to change the time format. The time can be 
displayed in either the 24 hours or 12 hours format.  
 

Time separator: : 

Time separator. This setting allows you to set the time separator. The default is the 
“:” symbol. Press the Smartpad Enter key to enter the modification mode. Use the 
Smartpad arrow up and down keys to change the time Separator symbol. The time 
separator can be changed in  “.” or “:“. 
 

Language: English  

 Language. Select the language for the Local Menu. 
 

Prefered interface: Bluetooth  

Prefered interface. Select the prefered interface; Bluetooth® or USB. If the ALVA 
BC640 is connected to two mainstream devices using its Bluetooth® and USB 
connection, the ALVA BC640 will only “communicate” with the prefered interface. By 
default the prefered interface is Bluetooth®. In the default situation, when the ALVA 
BC640 is connected to two devices via Bluetooth® and USB, the ALVA BC640 will 
only “communicate” with the Bluetooth® connection. The USB connection will be 
ignored. The hotkey to change the prefered interface is Smartpad 2 + Smartpad 3 + 
Cursor Routing Key 1 for the Bluetooth® connection and Smartpad 2 + Smartpad 3 + 
Cursor Routing Key 40 for the USB connection.  
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BT MAC: xxxx:xx:xxxxxx 

 BT MAC refers to the ALVA BC640 Bluetooth® MAC address. A Bluetooth® MAC 
address uniquely identifies a Bluetooth® device. 

   

Firmware: 1.10.64 BT: 1.11.0   

 Firmware version presents the version of the built in ALVA BC640 software and the 
software version for the Bluetooth® module. If a Braille Audio Feature Pack has been 
installed the second number after “BT” represent the firmware version for the Braille 
Audio Feature Pack. Please make sure that the firmware versions are equal to or 
higher than 1.14.0 BT: 1.16.0 1.4.0 when using the ALVA BC640 with Braille Audio 
Feature Pack. Please refer to chapter 8 for detailed instructions on how to update the 
firmware. 

 

Hardware: 18 

 Hardware version presents the version of the ALVA BC640 hardware revision. 
 

Firmware update 

Firmware update. When activated with the Smartpad Enter key, the ALVA BC640 
will be in “Firmware Update” mode. Please refer to chapter 8 for detailed instruction 
on how to update the firmware. 
 

Restore Factory settings 

Restore factory settings allows you to restore the factory settings. If you select this 
option the ALVA BC640 factory defaults will be restored. Alternatively, the ALVA 
BC640 factory defaults can be restored by deleting the SETTINGS.A6 file from the 
internal ALVA_BC6 drive. To delete the SETTINGS.A6 file: 

- Connect your ALVA BC640 to the USB port of your PC using the supplied USB 
cable 
- The ALVA_BC6 driver will automatically appear 
- Locate and open the system folder 
- Locate the SETTINGS.A6 file 
- Delete the file  

 
Note: The system folder is a hidden folder. To see hidden folders, you have to enable 
“show hidden files and folders” in Windows Explorer. 
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Test mode 

Test mode Use the test submenu if you have the impression that certain keys or 
Braille cells are not responding properly. The ALVA BC640 has two built-in tests: a 
Braille cell test and a key test. When activating the key test, pressing a particular key 
provides a unique dot pattern on the array of Braille cells. The Braille cell test will 
cycle all dots continuously. Pressing Smartpad key 1 to exit the test mode. 
 

4.3. The Feature Pack Menus 
The ALVA BC640 with Braille Audio Feature Pack has two extra menus: the 
Bluetooth® connection menu and Audio menu. 
 

4.3.1. The Braille Audio Feature Pack Bluetooth® Menu 
To enter the ALVA BC640 Bluetooth® Menu press Smartpad key 2 + Smartpad key 3 
+ arrow left simultaneously. To exit the Bluetooth® Menu press Smartpad key 1. The 
Smartpad keys are located on the top of the unit below the Braille line. The arrow 
keys and Enter key are located in the center of the Smartpad. The four remaining 
keys are labelled from left to right: Smartpad key 1 to 4. Please refer to chapter 2 for 
a detailed description of the keys of the ALVA BC640 Base Unit and Braille Audio 
Feature Pack. 
 

BT: Braille keyboard stereo mono 

Bluetooth® Menu. The Bluetooth® Menu shows the status of the various 
Bluetooth® connections. If a connection is activated dot 7 and 8 will be raised to 
indicate the connected state. Clicking on a connection with the cursor routing keys 
will connect or disconnect the particular Bluetooth® connection. Note that the 
Windows drivers will try to reconnect the Braille connection. Therefore it is highly 
recommended to disconnect the Braille in the screenreader and not from the ALVA 
BC640. Secondly, dismantling the keyboard from the ALVA BC640 will prevent the 
ALVA BC640 driver to reconnect the keyboard until it has been connected from the 
PC again. In general, it is recommended to have the ALVA BC640 software taking 
care of the connections. Manually connecting and disconnecting any Windows 
Bluetooth® connection from the ALVA BC640, except the stereo connection, may 
result in unexpected behaviour. 
 
The first time te ALVA BC640 is trying to reconnect the audio and keyboard, the 
Windows Bluetooth® software will generate a sound and show a popup window, 
asing for permission to have the ALVA BC640 automatically reconnect the audio and 
keyboard. To make sure the audio and keyboard automatically reconnect when a 
connection is lost or during a restart of Windows or the screenreader, please select 
the checkbox to always allow the connection and click the OK button. Please follow 
this procedure for the keyboard connection, mono connection and stereo connection. 
Should the popup not appear at the Bluetooth® notification sound, click on the 
Bluetooth® icon in the system tray next to the clock.  
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4.3.2. The Braille Audio Feature Pack Audio Menu 
To enter the ALVA BC640 Audio Menu press Smartpad key 2 + Smartpad key 3 + 
the arrow right key simultaneously. To exit the Audio Menu press Smartpad key 1. 
The Smartpad keys are located on the top of the unit below the Braille line and cursor 
routing keys. The arrow keys and Enter key are located in the center of the Smartpad. 
The four remaining keys are labelled from left to right: Smartpad key 1 to 4. Please 
refer to chapter 2 for a detailed description of the keys of the ALVA BC640 Base Unit 
and Braille Audio Feature Pack. 
 

Audio: BT USB Off Exit 

Audio Menu. The Audio Menu shows the availability and status of the Bluetooth® 
and USB audio. And audio channel is active and available when shown in the menu 
and underlined with dot 7 and 8. To switch to another audio channel, click the cursor 
routing key on the audio channel. Clicking the cursor routing key on the menu item 
“off” wil disable the audio, whereas clicking on “Exit” will close the menu.  
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5. Power Sources 
 
There are three ways to power the ALVA BC640: 
 
� Using the USB power (Base Unit only); 
� Using the internal battery; 
� Using the external power adapter 

 
In the subsequent sections, you will find more information about each power option. 
 

5.1. USB power 
If you connect your ALVA BC640 directly to a PC using the USB connection, the PC 
will provide power to the Braille display through the USB cable. To power the ALVA 
BC640 with Braille Audio Feature Pack, please use the power supply that came with 
the unit. Please note that only the ALVA BC640 Base Unit can be powered via the 
USB connection. The USB connection provides sufficient power to charge the base 
unit’s internal battery and to operate the ALVA Braille Controller Base Unit. 
 

5.2. Internal battery  
The ALVA BC640 runs on an internal battery in case no external power is attached or 
no USB connection is used. The ALVA BC640 will approximately run 12 hours on a 
fully charged battery. Typically, the internal battery is used in case of a wireless 
Bluetooth® connection. 
 

5.3. External power adapter 
An external power adapter is provided with the ALVA BC640 package. As soon as 
the external power adapter is connected to the Braille Controller, the battery will be 
charged and the ALVA BC640 will draws its power from this adapter. Please note 
that the ALVA BC640 with Braille Audio Feature Pack cannot be charged via the USB 
connection. Charging an empty battery will take approximately 4 hours. The external 
power can be used in combination with wireless Bluetooth® technology or the USB 
connection.  
 
Warning! Do not use another external power adapter than the one supplied in 
the ALVA BC640 package. 
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6. The ALVA BC6 Bluetooth® settings application 
 
This chapter describes the use of the ALVA BC6 Bluetooth® settings application. 
This application can be found in the Start Menu/ Programs/ Optelec/ ALVA_BC6 
folder. When having paired the ALVA BC640 with Braille Audio Feature Pack with the 
PC and having installed the screenreader drivers and Bluetooth® software, this 
application enables configuration of the connection settings of the Braille keyboard 
and mono and stereo Bluetooth® audio. 
 
The ALVA BC6 Bluetooth® settings application enables configuration of the 
automatic connection of the keyboard and audio when activating the screenreader. In 
case the connection gets lost, the application automatically instructs the ALVA 
BC640 driver to reconnect the keyboard and audio. 
 
In order to enable this functionality, you will have to create the keyboard and audio 
connections once, using “My Bluetooth® Places”. The first time the ALVA BC640 
driver creates the audio and keyboard connection, the Windows Bluetooth® will 
generate a sound and a popup window asking for permission to have the ALVA 
BC640 automatically reconnect the audio and keyboard.  
 
To make sure the audio and keyboard automatically reconnect when a connection is 
lost or during a restart of Windows or the screenreader, please select the checkbox 
to always allow the connection and click the OK button. Please follow this procedure 
for the keyboard connection, mono connection and stereo connection. Should the 
popup not appear at the Bluetooth® notification sound, click on the Bluetooth® icon 
in the system tray next to the clock.  
 

6.1. Configuring Audio 
There are two settings: 
� Automatically connect Bluetooth® Braille keyboard; 
� Manually connect Bluetooth® Braille keyboard. 

 
If the first setting has been selected, the ALVA BC640 will automatically connect the 
Braille keyboard when activating the screenreader. In case the connection gets lost, 
the keyboard will attempt to reconnect automatically.  
 

6.2. Using the Braille keyboard 
The Bluetooth® audio settings are only available in Windows XP. The audio settings 
are greyed out in Windows Vista. The security restrictions of Windows Vista prevent 
the ALVA BC640 software from configuring the audio connections. It is therefore 
recommended to use the stereo connection in Windows Vista, as the stereo 
connection is more reliable and provides a better audio quality. 
 
There are three settings: 
� Automatically connect mono Bluetooth® audio; 
� Automatically connect stereo Bluetooth® audio; 
� Manually connect Bluetooth® audio 
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In order to have the sound correctly routed to the ALVA BC640 in Windows XP, 
please select the audio playback devices for the default audio device, the Bluetooth® 
mono playback device and the Bluetooth® stereo playback device. Please note that 
these options are not available in Windows Vista. 
 
The name of the default audio device depends on the brand and model of the sound 
card manufacturer. The mono Bluetooth® device is in most situations labelled as 
Bluetooth-audio. To select the stereo Bluetooth® audio device first, you will need to 
create a Bluetooth® stereo connection: 
1. Open “My Bluetooth Locations”; 
2. Go to “Find Bluetooth Device”; 
3. Search for ALVA BC640 FP and make sure it is paired; 
4. Press Enter on ALVA BC640 FP to create the stereo connection; 
5. (Re)start the ALVA BC6 Bluetooth® settings application; 
6. Select high quality Bluetooth® audio to set the stereo Bluetooth playback to 

audio device. 
 
To save the settings to all users, make sure the “Save to default user” is checked and 
press Enter on the “OK” button. To save the settings to the current user, make sure 
the checkbox is not selected. 
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7. Using the Braille keyboard 
 
This chapter gives an overview of the Braille key combinations to emulate keyboard 
function keys. There are two types of function keys; chord commands to emulate 
keyboard function keys and prefix chord commands to emulate function key 
combinations. 
 

7.1    Chord commands  
 
Chord commands are Braille key commands in combination with the space bar. 
These chord commands are used to emulate keyboard function keys such as Home, 
End, Backspace, Delete and Escape. Please refer to the figure below for an overview 
of the chord commands: 
 
Chord command Keyboard key 
Backspace Space + b12 
Escape Space + b15 
Delete Space + b45 
Page up Space + b13 
Page down Space + b46 
Home Space + b123 
End Space + b456 
Tab Space + b56 
Shift-Tab Space + b23 
Shift-Space Space + b7 
 

7.2    Prefix chord commands  
 
There are three prefix chord commands to emulate the function keys F1 to F12 
(Space + b124 for activating F, followed by the number 1 to 12), Insert (Space + b24) 
and Caps Lock (Space + b14) combinations.  
 
To press one of the function keys F1 to F12, press Space + b124 (Space + F) 
followed by a character. The function key number is represented by the characters 
“a” to “I” whereby the character “a” represents F1 and “I” represents F12. To press F1 
using the ALVA BC640 Braille keyboard, first type space + b124 followed by the 
character “a” (Braille key 1). Press the Space + b124 combination again to exit this 
function.  
 
Similarly, the Insert and Caps Lock can be typed by pressing Space + b24 for Insert 
and Space + b14 for Caps Lock. To type an Insert + J command, press Space + b24 
followed by a “j” (Braille keys 2, 4, 5). Typing the Insert or Caps Lock command twice 
will switch the status of this command on or off, depending on the current status. 
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7.3    Contracted Braille on/off 
 
The chord + g command or Space + b1245 will turn contracted Braille (Grade 2) on 
or off. The contacted Braille table can be best set in the Local Menu/ Braille 
configuration/ Contracted Braille table.  
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8. Notes 
 
The Notes application enables writing and saving notes on the internal memory of the 
ALVA BC640 with Braille Audio Feature Pack. Notes contains a few elementary text 
adding and editing functions, such as copy, cut, paste and a block function. 
 
To use Notes no PC connection is required. In case the ALVA BC640 is connected to 
a PC, you can continue working with the PC after closing Notes. The ALVA BC640 
Braille keyboard has to be used to enter Notes. It is not possible to enter text in Notes 
via the PC keyboard. 
 
Text entered in Notes will be saved in a proprietary Braille format. The typed Braille 
characters will be saved in the same format as they have been entered. This means 
the characters are independent of any Braille code. Please keep in mind that Notes is 
not compatible with Microsoft Word or other similar text application. Therefore, it will 
not be possible to open Word documents in Notes or Notes documents in Microsoft 
Word. Text that has been entered in Notes can only be opened, read and edited in 
Notes. 
 

8.1 Starting Notes 
  
To start the Notes application: 
 
1. Open the Local Menu by pressing Smartpad key 2 + Smartpad key 3 + the arrow 

down key simultaneously. Use the arrow down key to navigate through Notes 
and press the Smartpad Enter key to start Notes. 

2. Press Smartpad key 2 + Smartpad key 3 + the arrow up key simultaneously to 
start Notes directly. 

 
In both situations Notes will open a new page. 

 8.2  Using Notes 
 
This paragraph will describe the various edition options of Notes in more detail. 
 

8.2.1 Adding text 
Notes can be entered using the ALVA BC640 Braille keyboard. An Enter will be 
displayed as an empty cell followed by a cell with all 8 dots raised followed by 
another empty cell. 
 

 8.2.2 Editing text 
Use the following chord commands to edit text. 
 
Chord command Keyboard Key 
Backspace Space + b12 
Delete Space + b45 



Optelec   

English   Page 31 

 

 8.2.3 Navigating in Notes 
Please use the following commands to navigate through the text: 
 
Chord command Keyboard Key 
Previous character Space + b3 
Next character Space + b6 
Previous line Space + b1 
Next line Space + b4 
Previous word Space + b2 
Next word Space + b5 
 
Alternatively, the cursor routing keys can be used to move the cursor and navigate 
through the text. 
 

 8.2.4 Defining a block 
Please follow the procedure below to define a text block: 
 
1. Place the cursor at the beginning of the defined block; 
2. Press Ctrl+J to mark the beginning of the block; 
3. Move the cursor to the end of the block;  
4. Press Ctrl+K to mark the end of the block. 
 
The defined block can be copied or cut and pasted to a prefered position in the text. 
The short keys for cut, copy and paste are, Ctrl+X, Ctrl+C and Ctrl+V. Alternatively, 
the commands can be found in the Notes menu. 
 

 8.2.5 Reading in Notes  
The following commands have been defined for reading text in Notes: 
 
Command ALVA BC640 Key 
Previous word Thumb key 1 
Start of line Thumb key 2 
Start of next line Thumb key 3 
Next word Thumb key 4 
 
Pressing thumb key 2 while the cursor is within the line will move the cursor to the 
beginning of the current line. Pressing thumb key 2 again will move the cursor to the 
beginning of the previous line. 
 
In case the entered text in Notes does not contain any new line commands (Enters) 
thumb key 2 and 4 will move the respectively the beginning and end of the text. 
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 8.3 The Notes Menu 
 
The Notes menu can be activated by pressing the Alt-key. Click on the cursor routing 
key to activate a menu item. To exit the menu, click the Alt-key again. Notes menu 
options can be activated with short keys. Please refer to paragraph 8.4 for a list with 
short key combinations.  
 

 8.3.1 Notes main menu 
To enter the main menu, press the Alt-key. The Notes main menu consists of the 
following three submenus: 
� File 
� Edit  
� Help 
 
Press the Alt-key again to exit the main menu. 
 

 8.3.1.1 File menu 
To enter the File menu, click on File in the main menu, using the cursor routing keys. 
The File menu contains the following options: 
� New 
� Open 
� Save 
� Save As 
� Exit 
 
New Note 
To create a new note, click on New in the File menu. In case the current note 
contains unsaved text, Notes will ask you to save the changes. 
 
Open a Note 
To open an existing note, click on Open in the File menu, using the cursor routing 
keys. A list with existing notes will be displayed. Navigate through the list using the 
Smartpad arrow up and down keys. Press the Smartpad Enter key to open the 
selected note. 
 
Save a Note 
To save a note, click on Save in the File menu. If the note has no name yet, you will 
be prompted to enter a new name. 
 
Save As 
Clicking on Save As will prompt you to give your current note a name. If the name 
already exists you will asked to overwrite the existing file. Clicking on “No” will prompt 
you to enter a different file name. 
 
Exit Notes 
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Clicking on Exit will close Notes. If the current note is not saved, you will be prompted 
to save the file. While clicking “Yes” you will be asked to enter a file name. Clicking 
“No” will close Notes without saving the file. 
 
 8.3.1.2 Edit menu 
The Edit menu contains the following options: 
� Undo 
� Cut 
� Copy 
� Paste 
 
Undo 
To undo the last change, click on “undo” in the Edit menu. 
 
Cut 
By clicking “cut”, the selected block or character will be cut. The selected block or 
character can be pasted on a different location in the text. The shortcut for “cut” is 
Ctrl+X.  
 
Copy 
By clicking “copy”, the selected block or character will be copied. The selected block 
or character can than be pasted on a different position in the text. The short key 
combination for “copy” is Ctrl+C. 
 
Paste 
To paste a “cut” or “copied” block, click “paste”. Alternatively, use the short key 
combination Ctrl+V. 
 

 8.3.1.3 Help 
The Help menu displays the about screen. Press Space+b15 to exit this screen. 
 

 8.4 Notes Short Key Combinations 
 
Below is an overview of the most frequently used short key combinations: 
 
Command Keyboard Key 
Previous line Space + b1 
Previous word Space + b2 
Previous character Space + b3 
Next line Space + b4 
Next word Space + b5 
Next character Space + b6 
Backspace Space + b12 
Delete Space + b45 
Escape Space + b15 
Copy Space + b14 
Mark start of block Space + b245 
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Mark end of block Space + b13 
New note Ctrl + b1345 
Open note Ctrl + b135 
Save note Ctrl + b234 
Paste Ctrl + b1236 
Open / Close Notes Menu Alt 
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9. Updating the Firmware 
 
The ALVA BC640 firmware can be updated using the supplied firmware update 
software. The ALVA BC640 Firmware Updater is located in the Start Menu/ 
Programs/ Optelec/ ALVA BC640 Updater. Please read this chapter carefully before 
attempting to update your ALVA BC640 firmware. 
 
Caution: 
� An incorrect update of the ALVA BC640 firmware will seriously damage the 

ALVA BC640, which may result in having to return the unit to the factory for 
repair. 

� An incorrect applied firmware update is not covered by warranty. 
� Please check if the battery is charged and if the ALVA BC640 is connected to 

the power supply before applying the firmware update. 
� Please remember to never switch off the ALVA BC640 while the firmware 

update is in progress. 
 
To start the firmware update procedure, please follow the following steps: 
1. Switch the ALVA BC640 on; 
2. Connect the ALVA BC640 to the PC using the USB cable that came with the unit; 
3. Activate the ALVA BC640 Local Menu by pressing Smartpad key 2 + Smartpad 

key 3 + arrow down simultaneously; 
4. Start the ALVA BC640 Firmware Updater, which is located in the Start Menu/ 

Programs/ Optelec/ ALVA BC640 Firmware Updater and follow the on screen 
instructions carefully; 

5. When the ALVA BC640 Firmware Updater asks you to put the ALVA BC640 in 
firmware update mode, locate the “Firmware Update” in the Local Menu, by 
pressing Smartpad key 2 + Smartpad key 3 + arrow down simultaneously. 
Navigate through the Local Menu, using the arrow up key and press the 
Smartpad Enter key to select “Firmware Update”. If this is the first time you 
update the firmware, a hardware wizard will appear asking to install the 
necessary USB drivers. Please follow the instructions to install the USB drivers. 

6. Please wait until the firmware update is finished and the message “Bluetooth 
base module updated” is being displayed on the ALVA BC640. This might take 
several minutes. 
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10. Mounting the Braille Audio Feature Pack 
 
The ALVA BC640 Braille Audio Feature Pack clicks onto the back of the ALVA 
BC640 after which it will be secured with two 2.5 mm hex screws (see picture below). 
 
1. Switch off the ALVA BC640 
 
 
 
 
 
 
 
 
 
2. Click the Feature Pack to the ALVA BC640 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. Tighten the 2 Feature Pack screws with the 2.5 mm hex key 
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Regulatory notice 
This equipment has been developed and tested in order to comply with the following 
regulations: 
 
   and  for a Class B digital device, pursuant to part 15 rules. 
 
 
These limits are designed to provide reasonable protection against harmful 
interference in a residual installation. This equipment generates, uses and can 
radiate radio frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications. However, 
there is no guarantee that interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or television reception, which 
can be determined by turning the equipment off and on, the user is encouraged to try 
to correct the interference by one of the following measures: 

� Re-orient or relocate the receiving antenna. 
� Increase the separation between the equipment and receiver. 
� Connect the equipment into an outlet on a circuit different from that to which 

the receiver is connected. 
� Consult the distributor or an experienced technician for help. 

 
Medical electrical equipment needs special precautions regarding EMC (Electro 
Magnetic Compatibility) and needs to be installed and put into service according to 
the EMC guidelines. 
WARNING: The use of accessories, transducers and cables other than those 
specified and sold by the manufacturer of the ALVA BC640 as replacement parts for 
components, may result in increased emissions or decreased immunity of the ALVA 
BC640. 
 
By design the ALVA BC640 will shut down in case of an ESD 8KV test pulse. The 
ALVA BC640 will need to be switched on again to resume. 
 
 
 
CE Caution:  
� That SIP/SOPs need to be connected properly and that any unused SIP/SOPs 

shall not be accessible for the users to contact to other nonrecommand devices 
in the user area . 

� The unit is for exclusive interconnection with IEC/EN 60601 certified equipment 
outside of user environment and IEC/EN 60601-1 certified equipment inside the 
user environment. 

� This device comply with EN 60601-1-2, to minimize the interference from other 
equipment. 

� Equipment connected to the analog or digital interfaces must comply with the 
respective IEC/EN standards (e.g. IEC/EN 60950-1 for data processing 
equipment and IEC/EN 60601-1 for medical equipment). 

� To reduce the risk of electric shock, make sure power cord is unplugged from 
wall socket. To fully disengage the power to the unit, please disconnect the 
power cord from the ac outlet. Do not remove cover(or back). No user 
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serviceable parts inside. Refer servicing to qualified service personnel. The AC 
outlet shall be readily available and accessible. 

� Furthermore all configurations shall comply with the current version of the 
standard for SYSTEMS IEC/EN 60601-1-1. Everybody who connects additional 
equipment to the signal input part or signal output part configure a medical 
system, and is therefore responsible that the system complies with current 
version of the requirements of the system standard IEC/EN 60601-1-1. If in 
doubt, consult the technical service department or your local representative." 

 
Explanation Of Graphical Symbols:  

 

This symbol warns user that uninsulated voltage within the unit may have 
sufficient magnitude to cause electric shock. Therefore, it is dangerous to 
make any kind of contact with any part inside this unit. 

 

This symbol alerts the user that important literature concerning the operation 
and maintenance of this unit has been included. Therefore, it should be read 
carefully in order to avoid any problems. 

 Stand-by 

 Direct Current 

 
Safety Logo:  

 
 

ALVA BC640  complies with the 
93/42/EEC, EN60601-1,EN60601-2 
of related European standards. 
 
Disposing of your old product:  
� Within the European Union  

EU-wide legislation, as implemented in each Member State, 
requires that waste electrical and electronic products carrying 
the mark (left) must be disposed of separately from normal 
household waste. This includes monitors and electrical 
accessories, such as signal cables or power cords. When you 
need to dispose of your display products, please follow the 
guidance of your local authority, or ask the shop where you 
purchased the product, or if applicable, follow any agreements 

made between yourself. 
The mark on electrical and electronic products only applies to the current European 
Union Member States. 
� Outside the European Union  

If you wish to dispose of used electrical and electronic products outside the European Union, 
please contact your local authority so as to comply with the correct disposal method. 

� Please follow the national guidelines for unit disposal. 
 
Classification:  
Power by Class I power adapter： 18UT-05-3000 
� No Applied Part. 
� No protection against the ingress of water： IPX0 
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� Mode of operation: Continuous Operation 
� The equipment not suitable for use in the presence of a flammable anesthetic 

mixture with air or with oxygen or nitrous oxide: Not AP or APG Category: 
 
 
 
Product Specifications:  

Specifications  

Power Adapter Input Voltage Range: 100 – 240 VAC 

 Input Frequency Range: 50 – 60 Hertz 

 Fuse: Internal and not user replaceable 

 Power Output: 5V  1.5A 

 Max Input AC Current: 90-264VAC  0.3A 

Environment  Operating Temperature: +0℃ ~ +40℃ 

Conditions Storage/Transportation 
Temperature:

-20℃ ~ +60℃ 

 Operation Relative Humidity: 20% ~80% Non-Condensing 

 Storage/Transportation 
Relative Humidity:

10% ~95% Non-Condensing 

 Atmospheric pressure: 500~1060 hPa 

 
FCC : 
 
This equipment has been tested and found to comply with the limits for a Class B 
digital device, pursuant to part 15 of the FCC rules. These limits are designed to 
provide reasonable protection against harmful interference in a residential installation. 
This equipment generates, uses and can radiate radio frequency energy and, if not 
installed and used in accordance with the instructions, may cause harmful 
interference to radio communications. However, there is no guarantee that 
interference will not occur in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can be determined by 
turning the equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures: 
-Reorient or relocate the receiving antenna. 
-Increase the separation between the equipment and receiver. 
-Connect the equipment into an outlet on a circuit different from that to which the 
receiver is connected. 
-Consult the dealer or an experienced technician for help. 

 
 
You are cautioned that changes or modifications not expressly approved by the party 
responsible for compliance could void your authority to operate the equipment. 
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This device complies with Part 15 of the FCC Rules. Operation is subject to the following two 
conditions: (1) this device may not cause harmful interference and (2) this device must accept 
any interference received, including interference that may cause undesired operation 
 
 
FCC RF Radiation Exposure Statement:  
This Transmitter must not be co-located or operating in conjunction with any other 
antenna or transmitter. 
This equipment complies with FCC RF radiation exposure limits set forth for an 
uncontrolled environment. To maintain compliance with FCC RF exposure 
compliance requirements, avoid direct contact to the transmitting antenna during 
transmitting. 
Any changes or modifications (including the antennas) made to this device that are 
not expressly approved by the manufacturer may void the user’s authority to operate 
the equipment. 
 
 
 
Warranty conditions 
Optelec warrants the ALVA BC640, effective from the date of delivery, to be free of 
any defects in material and workmanship.   
Warranty is not transferable and does not apply to groups, multi users or agencies. 
The ALVA BC640 has been designed for the individual purchaser to be used in home 
and office environments. Optelec reserves the right to repair or replace any 
purchased ALVA BC640 with a similar or better product. 
In no event shall Optelec or its distributors be liable for indirect or consequential 
damages. The original user’s remedies are limited to replacement of ALVA BC640 
modules. This warranty is valid only when serviced in the country of original purchase 
and with intact seals. For additional warranty claims or service during or after 
warranty period, please refer to your distributor. 
Optelec takes no responsibility for use of this device other than described in this 
manual.  
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Optelec offices worldwide 

Optelec U.S. Ltd 
3030 Enterprise Court, Suite C 

Vista, CA 92081 
U.S.A. 

T. +1 (800) 826-4200 
www.optelec.com 

 
Optelec Canada 

1832, Boulevard Marie-Victorin 
Longueil, QC J4G 1Y9 

Canada 
T : +1 (800) 665-3005 

www.optelec.com 
 

Optelec Limited 
2, Millfield House, Woodshots Meadow 

Croxley Green Business Park 
Watford, WD18 8YX 

United Kingdom 
T: +44 (0)1923 23 13 13 

www.optelec.co.uk 
 

Optelec Nederland BV 
Breslau 4 

2993 LT Barendrecht 
The Netherlands 

T: +31 (0)88 6783 555 
www.optelec.nl 

 
Optelec NV 

Baron Ruzettelaan 29 
B-8310 Bruges 

Belgium 
T: +32 (0)50 35 7555 

www.optelec.be 
 

Tieman GmbH 
Fritzlarer Strasse 25 
34613 Schwalmstadt 

Germany 
T: +49 (0)6691 96170 

www.tieman.de 
       

 
Optelec Corporate Headquarters: Breslau 4 - 2993 LT Barendrecht – The 

Netherlands – T: +31 (0)88 678 3444 – www.optelec.com  
 
 


